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Map Creation 
1.  When I try to paint vegetation objects onto the map, nothing happens. 

If you have the vegetation cursor showing, an object selected and still nothing is 
being painted, then try increasing the size of the brush. 

2.  The vegetation objects that I have placed on the map are displayed in big white 
squares when I zoom out, how can I change this? 

In order to render your new vegetation properly, you need to rebuild the terrain on 
the map.  Select Generate Surface Texture from the File menu, and wait while the 
editor builds your new map terrain. 

3.  Why is it when I zoom in close to my map the surface textures change to red? 

All surface textures need a surface detail texture, for when you zoom in close.  If 
you haven't set one, then you will see the red "replace me" texture when zoomed 
in.  Click on the Texture icon in the tool bar, and for each surface texture that is 
causing a problem, select and click the Edit Surface Type button.  In the Surface 
Types window you can allocate a surface detail texture file in the Detail Texture 
window. 

4.  I set a slope value of 90, but this doesn't seem to be horizontal or  

vertical line.  What gives? 

Slopes aren't represented in the game by degrees, so a value of 90 is not 90 degrees.  
The slopes are represented as a ratio of 90, with 0 being 0 degrees and 255 being 
90.  In this case 90 would represent 90/255 of 90 degrees, or about 32 degrees. 

5.  When I try to paint underwater vegetation onto the map, it won't show up, what 
is the matter? 

Your vegetation brush has a parameter defining what altitudes it is allowed to be 
painted on.  The default for this is 16 to 255, which means all altitudes above the 
default water level.  If you want the brush to paint below the sea level, you will 
need to change the ElevationMin parameter of the brush to 0.  You may also want 
to set the ElevationMax parameter to 16, to make sure you don't paint the 
underwater vegetation on the land. 
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6.  Why won't the brush appear when I try to modify the terrain on my map? 

If you are doing everything else right, and the brush is not showing, then you are 
probably trying to alter the terrain outside of the map's boundaries.  Try changing 
the terrain somewhere closer to the centre of the map and seeing if this fixes your 
problem. 

7.  I can't see mat_sand.  Why are there only a small number of materials in the 
Surface Type settings drop down box? 

The editor doesn't currently update this list automatically with the available 
materials.  The only work-around at present involves importing materials to the list 
by selecting objects.  All objects that you select will have the materials they use 
listed in the materials list after you double-click them.  You can also perform a text 
search on the extracted objects.pak file, to see what "mat_" types are contained in 
which object. 

8.  Why aren't there any shadows appearing under my brushes after I place them 
on the map and set the shadows on? 

You need to regenerate surface textures, before shadows will show on the terrain. 

 



 

Objects 
1.  All my objects are too dark, how can I fix this? 

It is likely that your ambient colors are too dark.  In the Rollup Bar, click on 
Terrain then Environment, and check the colours in the EnvState category of the 
Environment window.  If these are set to very dark colours then change them to 
something lighter.  Other aspects that can affect how dark objects appear on the 
map can be altered in the Terrain Lighting window.  Click on Lighting button in 
the toolbar.  From here you can increase the sun height, which will reduce shadows 
behind terrain and other objects.  You can also decrease the intensity of shadows, 
or turn them off completely. 

2.  I placed an object on the map, and I can't see it, where did it go? 

If you haven't set "Lock Movement to Follow Terrain" in the toolbar, then it is 
quite possible your object is deep underground.  Try raising the object to the 
surface by moving it along its Z axis, or just delete the object, and replace it with 
the "Lock Movement to Follow Terrain" icon set on. 

3.  How do I unfreeze an object when I can't select it. 

To unfreeze an object, you need to use the Select Objects window.  You can access 
this with the three coloured bar in a square object, to the right of the snap to grid 
and angle icons, on the tool bar.  In the Select Objects window you can change the 
Display List to Frozen, and this will display all the frozen objects on your map.  
With this list you can unfreeze any objects you want. 

4.  When I move objects, how can I get them to move in smaller or larger 
increments? 

You will need to change the snap to grid settings, which you can access from the 
main tool bar. 

5.  When I place a ladder in the map, I can't climb it. 

You are likely using a ladder from the Simple Entity directory.  Simple entities are 
just that: simple.  They cannot perform complex functions like player interaction.  
Use the ladders from the Entity directory instead.  
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Artificial Intelligence 
1.  I've made changes to the way the AI works, but it is not affecting the behaviour 
of the soldiers, what is the problem? 

Each time you alter the AI settings, you must generate AI triangulation.  Try 
running this function from the Tools menu, and see if this solves your problem. 

2.  I have set up way points across the building/bridge, but the AI won't cross onto 
it, what is the problem? 

Make sure that the entry and exit points are linked by way points, with no missing 
links whatsoever.  If the AI can't plot a path from the entry to exit, it won't enter.  
Don't put hide points in place of way points, use them as additional points for the 
AI to escape to if it is shot at.  Also make sure that the Navigation Modifier box 
crosses the Forbidden Zone, and that the entry and exit points are placed where 
these two areas overlap. 

3.  My defensive AI leader cannot get to his protection point, what is the problem? 

You will get this warning if the AI Anchor protect point is too difficult for the AI 
leader to plot a path to, for example if it is inside a maze of walls and objects.  Also, 
if the Anchor has been placed in the Forbidden Zone where an AI entity is 
prohibited from walking into, it will tell you that it cannot be reached. 

4.  The soldiers I have programmed to patrol in a vehicle immediately exit, or exit 
very soon after entering it, and then stand around doing nothing.  What is the 
problem? 

When you set up the vehicle and driver AI, you set a view range for both the 
vehicle and the soldiers.  The soldiers will exit the vehicle when the player comes 
into the vehicle's range, however if the soldier's view range is less than the vehicles 
view range, they will no longer be able to see the player, and so will return to their 
initial state, which is usually to do nothing.  Be sure to make the view distances of 
both the vehicle and the soldiers the same if you set them to patrol. 

5.  The vehicle I have set up to give chase ignores me when I pass, how can I make 
it respond? 

Make sure the view distance of the vehicle is enough to see you when you pass.  As 
the soldiers won't be getting out of the vehicle when you are nearby, unless the 
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vehicle is destroyed, you can set the view distance of the vehicle to be a lot higher 
than the soldiers when you are giving it on order to chase the player. 

6.  The soldiers won't get in the gunner seat of the vehicle, but only in the 
passenger seat, what have I done wrong? 

Probably nothing.  If you are using the Buggy, then the soldiers will not get in the 
gunner seat, even if it is available.  If you want a gunner, use the Humvee. 

7. My vehicle, player, AI entity, object, etc. is acting oddly, bizarrely, randomly, etc. 
what is the problem? 

During testing some settings can get changed and will need reloading.  If you don't 
reload them after testing, you may experience unusual behaviour the next time you 
test the game.  There are four settings that can need reloading, scripts, 
textures/shaders, geometry and terrain.  Unfortunately you aren't necessarily going 
to know what needs reloading to solve your problem, so sometimes you will need 
to load all four until you pinpoint what exactly is causing the bizarre behaviour.  
Sometimes it might not be this that is causing you problems, but this should be 
your first port of call when something odd happens after testing. 

8.  How do I make AIs take cover when fired upon? 

AIs in the open will hide behind any object with the "hideable" property set to true.  
See the AIs near Comment15 and Comment16 of the Demo to get a good idea of 
how this works.  In enclosed areas, you will need to use hide points.  See the 
Chapter 3 of the User Manual for more information. 

9.  How do I give my AIs weapons? 

If you are using a basic AI entity, you can give it an equipment pack, by selecting 
one in the Equipment property.  If you have already set one up, say with a P90, 
then the AI will get that weapon.  If you are using the Archetype Entity AIs, then 
you will need to set up the equipment packs for each one.  An easy way of doing 
this is to export the equipment packs from an existing level, like the Demo level, 
and import them into your own. 



 

Events 
1.  When I program an event to happen when the AI dies, by using the On Die 
event, it doesn't work? 

Use On OnDeath instead.  The Die event is sent to an AI to kill it, so if it dies by 
being shot by the player, this event will not be triggered. 

2.  I have triggers in the game, how do I test them with the AI/Physics button? 

When you are watching the AI/Physics of the game, without actually running the 
game itself, you can activate the triggered events by clicking on the trigger itself, 
then the event you want to trigger, and then clicking Send.  This will allow you to 
see what triggers do, without actually putting the player in the game.  This is useful 
if the player being in the environment will alter the behavior of other objects placed 
there. 
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Internal Areas 
1.  How do I make a swinging light? 

You will need to use a dynamic light, and set change the shakeRefreshTime 
parameter from the default zero, to some greater.  The larger the number, the less 
often it is shaken. 

2.  I placed a dynamic light in my level, but it won't swing, even though I have 
given it the correct shake parameters, what is the problem? 

Make sure that you have given the dynamic light a model other than invisible, as 
with an invisible model there is nothing for the game engine to shake.  Once you 
give it a model, by pointing to one with the lighttype parameter, the light should be 
shaken about its axis, or axes. 

3.  Is it possible to cut round holes in the terrain? 

No , only square holes can be cut. 
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Multiplayer Maps 
1.  Why won't the Phoenix object respawn my Hang-glider/AI? 

The phoenix isn't programmed to respawn hang-gliders or AI, if you want this to 
work you will need to re-program the script, or make a new object.  AI's can be 
resurrected with an event, but they aren't really designed for multiplayer maps, and 
may need some recoding themselves. 

2.  Why won't the Phoenix respawn any of my vehicles? 

Try testing the map in the game, rather than the editor. 

3.  Why can't I use physicalized objects in multiplayer? 

Objects need to be especially programmed to work in multiplayer, otherwise they 
won't update on client PCs.  Not all objects have been coded to work in 
multiplayer, i.e. those that aren't used in standard multiplayer maps.  If you want 
them to work, you will need to re-code them. 

4.  Can new multiplayer maps be automatically downloaded? 

In version 1.1 of Far Cry™, this is not possible, but it may be included in later 
versions. 
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Single Player Missions 
1.  How do I add a load screen to my level? 

You need to use the following code in the Mission:OnInit function in the Mission 
Script: 

System:SetConsoleImage("[yourimagesfilenamehere]", 0); 

See Chapter 7 for more information on editing the Mission Script. 

2.  When I try and edit the mission script, nothing happens, what is the problem? 

You need to associate a program, like notepad, with the script.  The default is 
ultraedit, but if you haven't got this you will need to change the program to 
something else using by selecting Preferences from the Tools menu and changing 
the Script Editor program under Files.  You should also find that associating an 
application like Notepad with .lua extensions will also work. 

3.  Why do I get the error "Unable to execute script '(mypath\level.lua)' Check 
syntax! Script not loaded." when I create a new mission script? 

The only work around for this at the moment is to browse for your mission script 
with the Browse option, and re-open the file in order to make the editor refresh the 
mission functions.  This should remove the error message. 

4.  Can I have more than one tag point on the radar? 

It is currently only possible to have one radar point showing. 
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Sound 
1.  How do I make global ambient sounds, rather than local? 

There is no way of setting global ambient sounds for a level, instead you must place 
a sound area that will encompass the entire playing area, and attach sounds to that 
instead. 

2.  My sound objects aren't working properly, what is the problem? 

Sounds in the editor can be a little problematic sometimes.  Try exiting the editor 
and reloading your level, and if that doesn't work, test it in the full game instead. 
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Cut Scene Editor 
1.  I set my cut-scene up to "play on load", but it doesn't run. 

The play on load feature is no longer supported; instead trigger your cut-scene to 
run when the level starts, by placing a trigger where the player spawns. 

Chapter 

9 



 

Modding 
1.  Where are the scripts located, and other game assets, and how do I access them? 

In the FCData folder of your installation directory, there a number of compressed 
.pak files.  You can open these with WinRar, or other suitable archiving software.
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Errors 
1.  When I generate surface textures I get the following error: 
C3DEngine::MakeSectorLightMap: Requested image size is bigger than size of 
current renderer window. This problem will be fixed in future releases. 

This is a known problem.  Maximise your Perspective view window and try again. 
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Miscellaneous 
1.  My map has been messed up by explosions and won't regenerate when I restart 
testing, how can I fix this? 

When the terrain is deformed by action in the game when you are testing, such as 
vegetation disappearing or beaches being deformed by explosions, you can reload 
the terrain.  This also works for other graphical problems, such as when soldiers 
remain in the dead position, you can reload geometry to reset them. 

2.  When I run the editor in game mode, everything is really sluggish, how can I 
speed things up? 

If you have a lot of objects on the map, try turning off the ones you don't need to 
look at.  It helps to make good use of the layers to achieve this.  If it still runs 
slowly, try turning off the various elements on the View window, as well as the 
different renders.  If it is still slow, check that you haven't left the AI/Physics 
option on by mistake, as this will slow the game down.  Finally, try restarting the 
editor, or even the whole computer itself. 

3.  When I press Control-G to test the game nothing happens, how do I get it to 
work? 

It is possible that you haven't set a spawn point for your map.  Without a spawn 
point, you may not be able to enter the map to test it, so Control-G will not work.  
Add a spawn point somewhere on the map and try again. 

4.  Why do I get a grey screen in the Perspective view when I start a new map. 

To start a new map you must select New from the File menu, and give your new 
level dimensions and a name.  If you fail to do this, then you will probably not be 
able to view anything in your perspective view. 

5.  When I test the level in the actual game, there are objects missing and it doesn't 
play properly. 

Remember to export your level before testing it, by selecting Export to Engine 
from the File menu. 

6.  How do I edit the .dds files?   
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You need a plug-in for Photoshop: 

http://developer.nvidia.com/object/nv_texture_tools.html 



 

 

 


